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You want to create memorable first impressions and deliver differentiated buying experiences to your
customer? You want to find out how your customers shop in today's digital world? What are the most
influential channels and touch points in their customer journey and how can you impact these? How
does this work for the new product category you wish to enter?

Customer Journey Map is a powerful technique for understanding what motivates your customers -
what their needs are, their hesitations, and concerns. Although most organizations are reasonably
good at gathering data about their customers, data alone fails to communicate the frustrations and
experiences the customer experienced. A story can do that, and one of the best storytelling tools in
business is the customer journey map.

Customer journey map uses storytelling and visuals to illustrate the relationship a customer has with
a business over a period of time. The story is being told from the perspective of customer, which
provides insight into the total experience of the customer. It helps your team better understand

and address customer needs and pain points as they experience your product or service. In other
words, mapping out the customer journey offers your business the chance to see how your brand first
engages a potential customer, and then moves through the touchpoints of the entire sales process.

In this Customer Journey Map tutorial we will walk you through the steps involved in creating a
Customer Journey Map in Visual Paradigm. If you want to know more about what is Customer
Journey Map (CJM), you can watch the video 'What is Customer Journey Mapping?' below:

What is Customer Journey Mapping?

Creating a Customer Journey Map
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1. Create a new project by selecting Project > New from the application toolbar. In the New
Project window, enter CIJM Tutorial as project name and click Create Blank Project.

£ New Project
Create New Project

Create a new local project or create project in VP Teamwork Server if you have logged in.

MName: CIM Tutorial
Author: Peter

Data type set: UML ~

Description:

Advanced Options
Create Blank Project

Cancel

2.  Create a new Customer Journey Map by selecting Diagram > New from the application toolbar.
In the New Diagram window, select Customer Journey Map and click Next. Enter Take a Tour

as diagram name and click OK to confirm.

€ New Diagram

= — | Customer Journey Map

Diagram Name:

Take a Tour|

Location: <Root=
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Customer Journey Map is a feature available under Visual Paradigm Online ("VP Online")/
Teamwork Server. If you are prompted to connect to a server, and if you are evaluating Visual
Paradigm, it is recommended that you Activate Local Repository (Quick Setup). If you are a
member of VP Online or Teamwork Server, click Login under Existing Registered User.

0 Customer Journey Map

This feature requires to register VPository for enabling the doud compatible services.

<>

Cloud Server (VPository) Registration

Register VPository for enabling doud compatible
services.

L5

Local Repository (Quick Setup)

Try out doud compatible services without
requiring to register our doud server
(VPository).

&

Existing Registered User

Login to your existing VPository or Team work
Server account.

4. A new Customer Journey Map is created, with four dummy stages created for you as default.

Read the section below to enter the stages.

€ CIM Tutorial * - Visual Paradigm Enterprise - m] X
Dash Project ITsM UeXceler Diagram View Team Tools Modeling Window Help
5 | | Takea Tour ﬁ
&
=]
:
% — “
&
g
a

Customer Experience

_ B

<Double click to edit> <Double click to edit>

<Double click to edit= <Double click to edit>

<Double click to edit>

<Double click to edit>

Recommendations

4

<Double click to edit> <Double click to edit>

Ig\ Diagram Backlog | E Model Explorer

s, 4

<Double click to edit>

G Create Deliverable

Customer Journey
Mapping

Entering stages
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1. Double click on Stage 1 at the top of the journey map and rename the stage to Explore
Itineraries.

Explore Hinerarieg n
)

2.  Repeatedly rename the other three stages to Book a Tour, Pre-Tour and During Tour.

-

3. We need one more stage. Click + on the right of the stage During Tour.

During Tour

B

4. Enter Post-Tour as stage name.

L

Entering touchpoints
A touchpoint is any time a potential customer or customer comes in contact with your brand. Follow
the steps below to enter the touchpoints for the stage Explore ltineraries.

1. Double click on the gray cell under the first stage Explore Itineraries to open the interface for
entering touchpoints under this stage.

-

Customer Experience

_ ‘Doubje Clrffk ?O Edﬁf;‘ h

2. Enter the touch points as shown in the table below. You should press Enter to create a new row
(of touchpoint).
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Edit
Label Title Description Reference
. Tours detail The page where details of various tours are presented <None> v
. Pre-sales support channel Ask questions before making a booking decision <Neone= v
L Tour booking page The page where user can book a tour <None> v
. Title or click ... to upload file Description <None= v
“ Cancel
Title Description Referencg
Tours detall The page where details of various tours are <None>
presented
Pre-sales support Ask questions before making a booking decision [<None>
channel
Tour booking page The page where user can book a tour <None>

3.  Click OK to confirm and return to the map. The touchpoints are presented as bullet points in the

cell.

o

Customer Experience

Entering customer thinking/feeling

* Tours detail
® Pre-sales support channel
® Tour booking page

Once the touchpoints are identified, identify what the customers think and how they feel for each
touchpoint. What do the customers think when they visit the website to find tours information? Are
they happy, unhappy or even frustrated? Think as a customer and list out all the customer thinking
and feeling. Follow the steps below to enter the customer's thinking and feeling for the stage Explore

ltineraries.
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1.

2.

Double click on the second gray

Customer Experience

Tutorial

cell under the first stage Explore lItineraries.

o

Enter the customer thinking as s

® Tours detail
® Pre-sales support channel
® Tour booking page

hown in the table below. You should press Enter to create a

new row (of customer thinking/feeling).

Edit
Label Title Description Reference
. Lack sophisticated tour searck Lacks the capability to search tour(s) by destination <None= A
. Brochure not printable Users want to print out the brochure for discussing v <None= A
. Lack realtime support channe Unable to solve user's question instantly <None> v
L] No way to compare tours Users want to find out an option that can keep the b: <Mone= v
. Title or click ... to upload file Description <None= A4
“ Cancel
Title Description
Lack sophisticated tour Lacks the capability to search tour(s) by destination country, city and
searching period

Brochure not printable

Users want to print out the brochure for discussing vacation plan with
friends

Lack real-time support channel

Unable to solve user's question instantly

No way to compare tours

Users want to find out an option that can keep the balance between
the pricing, travel arrangement and journey

Reference
<None>

<None>

<None>
<None>
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3. A customer thinking/feeling is generated through assessing particular touchpoint. Let's indicate
this relationship by specifying References. Under the Reference column of the first touchpoint
Lack sophisticated tour searching, select Tours detail to reflect the fact that the customer find
the search facility not satisfied when reading the tours detail page.

Title Description Reference
Lack sophisticated tour searct | .. Lacks the capability to search tour(s) by destination <None= v
Brochure not printable Users want to print out the brochure for discussing v _
Lack realtime support channe | ... Unable to solve user's question instantly
Tours detail
No way to compare tours Users want to find out an option that can keep the b: Pre-zales support channel

Tour booking page

Title or click ... to upload file Description ~rvunise - -

4. Repeat this step for the other touchpoints. Select Tours detail, Pre-sales support channel and
Tour booking page as references for the other touchpoints.

Edit
Label Title Description Reference
. Lack sophisticated tour searck | ... Lacks the capability to search tour(s) by destination Tours detail A
. Brochure not printable Users want to print out the brochure for discussing v Tours detail -
. Lack realtime support channe | ... Unable to solve user's question instantly Pre-sales suppertc.. w
L] No way to compare tours Users want to find out an option that can keep the b: Tour booking page v
. Title or click ... to upload file Description <None= -
m Cancel

https://lwww.visual-paradigm.com/tutorials/customer-journey-mapping.jsp Page 7 of 19



Visual Paradigm Tutorial
How to Develop a Customer Journey Map?

5.  Click OK to confirm and return to the map. The customer thinking and feeling are presented as
bullet points in the cell. The reference relationships are indicated as tiny icons appear after each
referenced and referencing item.

Stage Explore ltineraries

Customer Experience

® Tours detail [7]
#® Pre-sales support channel 7]
® Tour booking page 7]

® |ack sophisticated tour
searching [£)

#® Brochure not printable [2

® Lack realHime support
channel [&

® No way to compare tours [¢

Entering ideas for improvement
Finally, based on the finding above you can think of the improvement opportunities. Follow the steps
below to list the ideas for improvement for the stage Explore Itineraries.

1. Double click on the third gray cell under the first stage Explore Itineraries.

Stage Explore Hineraries

Customer Experience

® Tours detail 7]
#® Pre-sales support channel 7]
® Tour booking page 7]

® |ack sophisticated tour
searching [¢)

® Brochure not printable [7

® Lack realtime support
channel [#

® No way to compare tours [¢

Recommendations

<Double click to edit= I}

2.  Enter the ideas for improvement as shown in the table below. You should press Enter to create
a new row (of improvement idea).
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Edit
Label Title Description Reference
. Support advanced searching Support searching by destination country, city and pr Lack sophisticated..
. Support printer-friendly brocht | ... Support printer-friendly brochure so that user can pr Brochure not printa... v
* Support more sharing options Support more sharing options for tour details pages Brochure not printa...
. Support WhatsApp Provide dedicated WhatsApp suppeort Lack realtime supp.. +
. Allows comparison of tours Present the information of different tours in a way th Mo way to compare ..
. <MNone= v
ﬂ Cancel
Title Description Reference
Support advanced searching Support searching by destination country, city and  |Lack
period sophisticat
tour
searching
(Touchpoir
Support printer-friendly brochure Support printer-friendly brochure so that user can Brochure
print out a neat page for communication purposes  |not
printable
(Touchpoir
Support more sharing options for tour details  |[Support more sharing options for tour details pages |Brochure
pages like facebook, email, gmail, etc not
printable
(Touchpoir
Support WhatsApp Provide dedicated WhatsApp support Lack
real-
time
support
channel
(Touchpoir
Allows comparison of tours Present the information of different tours in a way No
that allows comparison way
to
compare
tours
(Touchpoir
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3.

Tutorial

Click OK to confirm and return to the map. The ideas for improvement are presented as bullet

points in the cell.

Stage

Customer Experience

Recommendations

Explore ltineraries

® Tours detail 7]
® Pre-sales support channel 7]
® Tour booking page &

® |ack sophisticated tour
searching [¢ 7]

@ Brochure not printable [ 7]

® |ack realtime support
channel [& &

® No way to compare tours [2

|

Finishing up the journey map

Now you've finished entering the touchpoints, customer thinking/feeling and ideas for improvement for

the first stage. Let's complete the other stages by following the tables below.

#® Support advanced searching
]

® Support printer-friendly
brochure [7

#® Support more sharing options
for tour details pages [&

® Support WhatsApp [7

® Allows comparison of tours

[

Touchpoints Title [Descriptifteferdnce
Tour [The <None>
bookinpage
page [where

user can

book a

tour
Compahy make|<None>
apps |booking

via

smart

phones

and

tablets

Thinking & Feeling Title [Descriptifitefergnce
Complj€ated (Tour
bookinghany  [booking
processteps  |page

are
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required
in
booking
UnablgUser Company
to want to [apps
book |make
via  [booking
smart [anytime
devicefnd
anywher
via
smart
devices,
and we
do not
support
that right
now

1%

Ideas for Improvement Title Descripti[ﬁteference
Simplifinstead [Compljcated
the [of booking
page [separatifgrocess
flow ofisteps
bookinpage by
page, try
to put
them on
same
page
Add [Teach |Compljcated
hints |customefisooking
to how to [proceds
fields ffill in the
booking
form
Suppojbevelop [Unablé
bookin[:n app [to
via  [for tour [book
apps |booking [via

smart
devicep
Touchpoints Title Descriptilﬁteference
TicketgThe <None>
details|page
page |with
details
about
the
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travellimto details|
inform i page

tickets

bought
Tour ([The <None>
details|page
page |with

details

about

the tour

which

include

the

scheduldgs

and

events

Thinking & Feeling Title |Descriptiitefergnce

No |Customef&cket:
direct |need details
way [to print |page
for out the
printingiicket
tickets
Lack [Customgiiour
recomwand adiojetails
that [know |page
aids [the
the [things
prepargiian

need to

do and

prepare

for the

tour
Lack [Customgiiour

functiofickets |printin

(local) jhow to

travel

to the

airport

and the

time

required

Ideas for Improvement Title Descripti[ﬁteference

Suppojrovide [No
a a clear [direct
direct |interfacejway
print [to print [for

©

ickets
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for

tickets

Providgist the |Lack

a items  [recommendation

plannimustomefthat
checklseed to laids
prepare [the
and pay [prepargtion
attention
to in
preparing
a
journey
ProvidfProvide [Lack
informdkien travelling
on transportatfiormation
how |informatiglocal)
to that
travel [helps
to the [custome
airportfto plan
for
transportation
to and
from
airport

Touchpoints Title Descriptibtefere nce
[Tour [Tour <Nonep>
guide |guide
guides
the
custome
through
the
whole
journey
Thinking & Feeling Title |Descriptiftefergnce
Unhapj@ustomeur
due tojdo not [guide
being [want
persugtiebe
to buy [persuaded
expensivg
souvergxpensivie
souvenir
that they
are not
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interestef

in
UnablgeCustomgiour
to want to |guide
commilgtoataun|cate
with  [with
local [local
peoplepeople

smoothly

Ideas for Improvement Title [Descriptifitefergnce

Train [The tour{Unhappy
the |guide [dueto
tour [must notjbeing
guide |be too [persudded
for hard-sellfto buy
better expengive
commuinication |souvenir
skills
EnsurgThe tour|Unablg
that |guide [to
the |should [commlinicatp
tour [be with
guide [skillful {local
knowslin the |peopls
the [languagq
languageguired
requirgi
to commun|cate
commiwiitate
with  [local
the [people
local [so that
peoplehe/she

can help

translate

for the

tour

Touchpoints Title [Descriptiftefergnce

Photo [We <None>
album |create

digital

photo

album

for

customefs

and

send

it back
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to the
customefs
after the
tour

Thinking & Feeling Title [Descriptifitefergnce
Delight€dstomgrhoto
when [love this Jalbum
receiviagrangement
the |and are
album [generally
delighted
with that
Ideas for Improvement Title Descriptiptefere nce
Easy |Provide [Delighted
album |capabilitywhen
sharingio easily [receiving
share anjthe
album orjalbum
photos
in album
Accoultielp Delighted
based [customepwhen
album [maintain|receiving
collectfmcords [the

of their [album
journeys
This
also
encourages
them to
choose
our
service
again
in the
future

The final journey map should look like this:
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“ -

Customer Experience

[} booking [7] for tickets [7) communication skills [¢) & Account based album
® Support printer-friendly ® Add hints to fields [ ® Frovide a planning checklist ® Ensure that the tour quide collection [
brochure [ ® Support booking via apps [ knows the language required

® Support more sharing options
for tour details pages [

# Provide information on how ta
travel to the airport [7

1o communicate with the local
people [

& Tours detail B ® Tour booking page B ® Tickets detail page B * Tour guide B & Photo album B

& Pre-sales support channel 7] ® Campany apps 5] ® Tour details page ]

® Tour booking page [5]

® Lack sophi tour ® Complicated booking process ® No direct way for printing & Unhappy due to being ® Delighted when receiving the
searching [7) 7] tickets [7) ] persuaded to buy expensive album [7) ]

& Brochure not printsble 7 5] ® Unable to book via smart ® Lack recommendations that souvenit [ 7]

® Lack reaktime support devices [ 7] aids the preparation [} 7] ® Unable to communicate with
channel @ 7 ® Lack travelling information local people [

& Noway to compare tours [ (local) [ 5
1]

Recommendations
& Support advanced searching ® Simplify the page flow of & Support a direct print function & Train the tour guide for better ® Easy album sharing [

& Support WhatsApp [2]
® Allows comparison of tours

B

Generating Document from Journey Map

At the bottom of the journey map there is a deliverable pane. On the left of the pane there is a
deliverable icon. To generate a deliverable, double click on it, enter the filename in the Generate
Deliverable window and then click Save.

AW
E'j Create Deliverable

The figure below shows the document generated. It contains the journey map (image) and the
touchpoints, customer thinking/feeling and ideas for improvements entered under the stages.

BHS O- Customer Journey Mapping docx [Compatibility Mode] - Ward TABLE TOOLS 7T EH - O X
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER DESIGN LAYOUT Sign inj
— — — [
Title Description Referance
1. Take a Tour options for tour details  details pages like facebook, email, gmail,
ake pages =
channel
- ] T = - Allows comparison of  Present the informatian of different o way to compare
e tours tours in 3 way that allows comparison tours
g e e a
= 1.2. Booka Tour
1.2.1. Touchpoints
- Tour baoking page The page where user czn bock 2 tour
. compzny 2pps Ta make booking vis smart phones and
tablets
1.2.2. Thinking & Feeling
Title Description Referance
1.1. Explore Itineraries ~ N N
- camplicated booking  Teo many steps are required in booking  Tour booking page
1.1.1. Touchpoines process
Title Description Reference . Unable ta book via User want to make bocking nytime and  Comgany 2pps
. smart devicas anywhers viz smart devicas, and we do
. Tours datail The page where details of various tours .
are presenta nat suppart that right now
. pra-sales support sk questions befors making 3 booking 1.2.3. Ideas for Improvement
channel ision P L a
. Tour booking page The page where user can book 3 tour - simplifythe page flow  Instead of separating steps page by complicated boaking
112, Thinling & Festing of booking page, try to put them on same page process
P f - Add hints te fields Teach customers how to fill in the comglicated booking
Title =i s baoking form process
. 1ack sophisticated tour  Lacks the capability to search tour(s| by Tours detail o 3 5
g e e . support booking via Develop 2n 3pp for tour baoking. unable ta baok via
apps smart devices
. srochure not printable  Users want to print out the brochure for  Tours dtsil
discussing vacation plan with friends 1.3. Pre-Tour
. ::l:neal—hne support  Unable to solve user's question instantly  Pre-sales support 131, Touchpoints
znnel channel
Title Description Reference
. N way to compare users want to find out an option that Tour booking page = =
tours can keep the balance between the - Tickets detail page. The page with details about the tickets.
pricing, travel arrangement and journey Bought

LISH [UNITED STATES)
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Categorizing the Map with Label
You can categorize items in cells with labels. Let's say we want to categorize touchpoints into system
touchpoints and human touchpoints. Perform the steps below for categorization.

1. Right-click on lane header Touchpoints and select Cells Format > Label from the popup menu.

-7 B— ® Touw

Add Persona > port channel 7] ® Com
Insert Row Above » page 7]
Insert Row Below >
Create Experience Chart pated taur ©

. il @5
Set Persona » printable [ 5] ¢ Una
Cells Format » Label
Format Row... Bullet Point {b
Maove Up Number

Recommendations — Move Down Consecutive Number

Hide Description
Delete Chart

2. Double click on the cell of touchpoints under the stage Explore Itineraries.
Q Tours detail 7]
(O Pre-sales support channel 7] Ih
O Tour booking page 7]

3.  Click on the hollow label next to the first item and select orange. We want to represent system
touchpoints with an orange label.

O Tours detail

Existing Label: '
annel

New Label:

oad file
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4.  Click on the hollow label next to the second item and select green. We want to represent human
touchpoints with a green label.
[ ] Tours detail

O Pre-sales support channel

Existing Label:

New Label:

d file

5.  Set the label for the third item be orange.

Tours detail
Pre-sales support channel
Tour booking page

Title or click ... to upload file

O @ o o

6. Click OK to confirm. The map is updated with orange and green labels applied to items.

® Tours detail 7]
@ Pre-sales support channel 7]
@ Tour booking page ]

7. At the bottom right of the map, double click on the captions in the legends and rename the
captions for orange and green labels to System and Human respectively.

juide for better ® Easy album sharing [}
n skills [# & Account based album
: tour guide collection [7

juage required
te with the local

@ System
@ Human
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Related Links
. More about Customer Journey Map

. Video - What is Customer Journey Mapping?
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